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OVERVIEW

The IL-DSP is a tiny USB-powered portable headphone amplifier and DAC
(digital-to-analog convertor). It provides high-fidelity playback of all audio and
music sources from phones, tablets and computers.

Technical performance of the IL-DSP is exemplary, with PCM digital audio

playback up to 24-bit 192 kHz, 0.0007% THD and 120 dBA signal-to-noise
ratio.

30 mW power output per channel is ample for IEMs and most portable
headphones. High-resolution PCM and DSD formats are both supported.

The ten bands of parametric EQ are configured with miniDSP's easy-to-use
computer interface. The fully adjustable peaking and shelving filters allow
adjustment of the audio band from the narrowest to the broadest control
ranges, with up to 16 dB boost or cut in each band. This combination of DSP
power, careful selection of high-quality components and a 32-bit audiophile
DAC combine to create an unparalleled portable headphone experience.

3.5mm
Headphone jack + . ‘
Android
{
\ 1 click: play/pause music
| or answer/hang up call
Volume Up ® 2 clicks: skip to next song
“ 3 clicks: skip back to previous song
Q-
\ All
Volume Down —— | .
. . / Press and hold -> LED goes dim = DSP enabled
Microphone ——p= = Press and hold -> LED goes bright = DSP disabled

Press and hold -> LED goes off = DAC turned off
(unplug and plug back in to turn on again)

Micro USB port —)@
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CONNECT TO ANDROID PHONE OR TABLET

Android
3.5 mm stereo plug - Phone/tablet

iniDSP IL-DSP ~
mini - .
®

M
USB Micro-B connector

USB OTG cable

1. Use one of the supplied OTG cables to connect your phone or tablet,
depending on whether your Android device has a USB-C or Micro USB B
socket.

2. Connect your headphones to the 3.5mm Headphone out on the front of
the IL-DSP.

3.  Play any audio-related app on your phone/tablet. Use the up and down
buttons to adjust volume for a comfortable listening level.

The inbuilt microphone can be used for phone calls or voice recording.

To adjust the EQ settings, you will need to connect the IL-DSP to your
computer and install the miniDSP plugin software. See pages 6 and 7.
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CONNECT TO COMPUTER

3.5 mm stereo plug 3

iniDSP IL-DSP -
mini - .
[

B S ——

USB Type A connector

USB Micro-B connector

USB cable

1.  Connect the USB cable supplied with the IL-DSP to a USB port on your
computer.

2. Connect the other end of the cable to the Micro USB-B on the IL-DSP.

Select the IL-DSP as the audio output device on your computer (see
pages 8 and 9).

4.  Run any software program that produces audio on the computer. Use
the volume up and down buttons on the IL-DSP to adjust volume for a
comfortable listening level.

5.  To adjust the EQ settings, you will need to install the miniDSP plugin
software. See pages 6 and 7.



NN
INSTALL SOFTWARE

To adjust the parametric EQ in the IL-DSP, you will need to install the miniDSP
software on your computer (Windows and Mac supported).

DOWNLOAD SOFTWARE

Log into your account on miniDSP.com. Click on your name at the top right of
the window and select User Downloads:

L Your Name Here ~

@® User Downloads
User Orders

# Account Maintenance

C» Logout

Click through to the IL-DSP section and download the IL-DSP package. After
downloading, unzip it (on Windows, right-click and select “Extract All...”; on
Mac, double-click).

INSTALL DRIVER (WINDOWS ONLY)

1. Connect the IL-DSP to the computer with the USB cable.

2.  Go to the WinDrivers folder of the software download and double-click
on the appropriate installer:

e miniDSP_UAC2_v2.29.3_ForWinXP_Vista.exe for Windows XP and
Vista

e miniDSP_UAC2_v4.47.0_ForWin7_8_10.exe for Windows 7, 8, and
10

The version number embedded in the filename may be different. We
recommend accepting the default installation location.
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INSTALL PLUGIN - WINDOWS

1.

Go to the Plugins folder of the software download and then to the
Windows folder.

Double-click on the IL-DSP.exe installer program to run it. We
recommend that you accept the default installation settings.

INSTALL PLUGIN - MAC

1.

Go to the Plugins folder of the software download and then to the Mac
folder.

Right-click on the IL-DSP.pkg installer program. Move the mouse over
the “Open With” item and then click on “Installer (default).”

v | IL_LDSP.v0_2_fwv1_2 7 Aug 2019, 6:53 pm
v [ Plugins 7 Aug 2019, 6:53 pm
¥ [ Mac 13 Jul 2019, 9:34 pm

[ @ ILDSPoks | ppen

M Installer.app (default) Open With >

If the following window appears, click on “Open.” We recommend that
you accept the default installation settings.

. “IL-DSP.pkg" is from an unidentified

« developer. Are you sure you want to open it?

p: Opening “IL-DSP.pkg” will always allow it to run on this
Mac.

Safari downloaded this file today at 11:30 pm from

www.minidsp.com

r»



NN
WINDOWS AUDIO

Note: playing USB audio from Windows requires that the UAC driver package
be installed first (page 6).

WINDOWS DEFAULT AUDIO DEVICE

Set the IL-DSP as the default audio output device. Open the Windows Control
Panel and navigate to the Audio Devices section. On the Playback tab, select
“IL-DSP” and click on the “Set Default” button.

D Sound X
Playback Recording Sounds Communications

Select a playback device below to modify its settings:

Q
Speakers

| |l Realtek High Definition Audio(SS

Default Device

Speakers

Ready

Configure Set Default ‘v Properties

ASIO

If your audio application program supports ASIO audio drivers, we
recommend selecting the miniDSP ASIO Driver in the settings of that
program. This typically allows the program to automatically change sample
rate. For example, in JRiver Media Center:

* Audio Device
¥ miniDSP ASIO Driver [ASIO]
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MAC AUDIO

Set the IL-DSP as the default audio output device. Open System Preferences
and on the Sound page, select the IL-DSP as the Output device.

[ ] < HH Sound Q, Searc

Sound Effects leliisiay Input

Select a device for sound output:

Name Type
Internal Speakers Built-in
IL-DSP USB

Settings for the selected device:

The selected device has no output controls

Output volume: o . ‘))) Mute

Show volume in menu bar

Individual audio playback programs may allow the IL-DSP to be selected for
audio output independently of the system default.

To select the sample rate that the computer uses to send audio to the IL-DSP,
open the Audio MIDI Setup program and click on Format.

® 0 Audio Devices
S Built-in Microphone T ~

2ins / 0 outs Y Channels 599G Format | Rate - |

- Clock €
K Sunf-/lrz\ Ol:tput 24 bit

AL O 2 ch Integer (44.1 kHz)

IL-DSP Sourcd v 2 ch Integer (48.0 kHz)

2ins / 2 outs L | 2 ch Integer (88.2 kHz)

Format 2 ch Integer (96.0 kHz)
2 ch Integer (176.4 kHz)

Channel Vo 5 ¢h Integer (192.0 kHz) d8 || Mute:/
VMaster§ 32 pit |
Mat 2 ch Integer (44.1 kHz) 0.0 |

USB OL 2 ch Integer (48.0 kHz) 0.0 |
uUsB ou 2 ch Integer (88.2 kHz) 6.0 :

2 ch Integer (96.0 kHz)
2 ch Integer (176.4 kHz)
2 ch Integer (192.0 kHz)

Configure Speakers...
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CONNECT WITH THE PLUGIN

With the IL-DSP connected to your computer, start the plugin:

e On Windows, locate the plugin in the Start menu. To make it easier to run
in future, right-click on its icon in the taskbar and select “Pin to taskbar.”

e On MacOS, locate the plugin in the Applications -> miniDSP folder. To make
it easier to run in future, right-click on its dock icon and select Options ->
Keep in Dock.

® 00 IL-DSP
File Restore Help

cR Yy
Ua\l IL-DSP o
FAYAUAL .
Y
Left PE Right PE r
e &
PARAMETRIC EQUALIZER Left BYPASS PEQ
M View Both Channels
20
15
10
5
0
5
-0
15
e 20 50 100 200 500 1000 2000 5000 10000 20000
EQ1 EQ3 EQS EQé EQ7 EQs EQ9 EQ10
:AND 1 " o o [¢] Filter type:
m Advanced Frequency 10 Gain 0.0 Q 05 RER

Click on the Connect button:
Y
C B Vv
Connect Connected

Click on Synchronize Config:

A MiniDSP device with Serial#965535 was detected. Please
choose from one of the following options:

Synchronize Config Restore Config

Help Cancel

10
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ADJUST PARAMETRIC EQ

There are three types of parametric EQ filter. The filter type is selected

towards the lower right of the settings window:

Filter type:
PEAK
PEAK
LOW_SHELF
HIGH_SHELF

There are ten bands of EQ. Select one by clicking on it:

EQ1 EQ2 EQ3 EQS EQ6 EQ?7 EQs EQ9 EQ10

There are three parameters that control each filter’s frequency response:

@ @ @
Frequency 10 Gain 0.0 Qg 05
Frequency

This is the center frequency of the filter. For PEAK, it is where
maximum boost or cut is. For HIGH_SHELF and LOW_SHELF filter
types, it is where the gain is half-way to the set value.

Gain
This is the maximum gain of the filter, in dB. If gain is positive, the
filter boosts; if gain is negative, the filter cuts.

This control the “sharpness” of the filter. For PEAK filters, a low Q

gives a broad boost or cut. For HIGH_SHELF and LOW_SHELF, a

higher Q gives a steeper transition to the shelf.
To control both channels at the same time, click on the Link icon:

|°
O~ & CD’
)

You can switch between EQ and no EQ with the Bypass EQ button:

seasspey ()

11
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PEAK

This filter creates a dip or a peak in the frequency response. If the gain is
positive, the filter boosts a frequency region around the specified frequency.
See the left side of this graph:

20

I I
15 ‘ Filter type: PEAK
Frequency: 3000
10 T 1 Gain: -10 1
5 | . . ! I 11 Q: 10
. =71 —— |
5 -1 | .| | Filter type: PEAK |
Frequency: 100
-0 -} . +—+—+ Gain: 5 1 ! ! ||
Q:0.7
20
10 2 50 100 200 500 1000 2000 5000 10000 20000

If the gain is negative, the filter cuts a frequency range. On the right side
above we have used negative gain, with a narrow frequency range set by
using a high value of Q.

LOW_SHELF and HIGH_SHELF

A low shelf filter reduces the gain below the specified frequency. On the left
side of the graph below, we have used a low shelf filter with positive gain to
provide a gentle bass boost:

15 Filter type: HIGH_SHELF
Frequency: 3000
L Gain: -10
5 -1 ! 1 Q1.2
; el mEnn
. Filter type: LOW_SHELF |
Frequency: 100 ‘ | {
g Gain: 5 =
15 Q: 0.5 ‘ ’ | } 1
. L |
10 P 50 100 200 500 1000 2000 5000 10000 20000

On the right side, we have used a high shelf filter with negative gain to cut
high frequencies by about 10 dB. The Q shown is higher than you usually use
for this type of filter.

12
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ADVANCED MODE

Click on the Advanced button to switch an EQ band to Advanced mode.

Basic Advanced

In Advanced mode, each filter band is specified by the biquad coefficients of
that filter. This is a set of five numbers that directly specifies the numerical
computations performed by the filter. The coefficients must be generated by
a filter design program (see next page).

Biquad coefficients can be entered or pasted directly into the user interface:

EQ1 EQ2 EQ3 EQ5 EQé EQ7 EQ8 EQ9 EQ10
PARAMETRIC EQ biquad1, |4 CLEAR
BAND 1 b0=1, F IMPORT

b1=0, —

Basic [Moned v| (O 441kHz (=) 48kHz PROCESS

The format of the text entry field is as follows:

biquadil,

b0=0.998191200483864,

b1=-1.9950521500467384,

b2=0.996920046761057,

al=1.9950521500467384,

a2=-0.9951112472449212
After entering or pasting in the coefficients for a band, press the Process
button.

Biguads can also imported from a file. The file can contain from one to ten
biguads in the format given above. Note that commas must separate each
biquad, and the last line of the file should not end with a comma. Click on the
Import button to import a biquad file.

e Biquads are always imported starting from filter band EQ1, regardless of
the numbering in the biquad file.

e The same number of biquads as in the file are imported. However, some
programs (e.g. REW) generate a file with ten biquads even if only some
have coefficients.

13
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BIQUAD SAMPLE RATE

Biquad coefficients must be calculated by a filter design program. Any
program that calculates biquad coefficients must do so at a specific sample
rate. The IL-DSP operates internally at two different sample rates:

e 441 kHz if the input sample rate is 44.1, 88.2 or 176.4 kHz
e 48 kHz if the input sample rate is 48, 96 or 192 kHz

Therefore, unless you are sure that you only will be playing back at one of the
above sets of sample rates,* you will need to calculate and load two sets of
biquad coefficients, one at 44.1 kHz and one at 48 kHz.

To load biquads at a specific sample rate, simply select the appropriate radio
button and then use the Process or Import button as described on the
previous page.

() 44.1kHz (%) 4BkHz

BIQUAD CALCULATION SPREADSHEET

The community-developed biquad calculation spreadsheet allows biquad
coefficients for many filter types to be calculated, including notch filters,
Linkwitz transforms, and filters with arbitrary Q-factor. Access this
spreadsheet here (requires Microsoft Excel):

o All_digital coefs v1-20101026.zip (on minidsp.com)

Room EQ WizARD (REW)

Room EQ Wizard (REW) is a free acoustic measurement and analysis tool,
available for Windows, Mac and Linux. It can generate a bank of parametric
EQ biquads based on a measurement. Room EQ Wizard can be downloaded
here:

e http://www.roomeqwizard.com/#downloads

For guidance on using this feature, please refer to this app note:
e Auto EQ with REW

1 Android devices only output at one sample rate and convert all other sample rates.
Typically, Android devices output at 48 kHz although we have also seen 96 kHz. In any
case, loading biquad coefficients at 48 kHz only should suffice for an Android device.

14
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SAVING AND LOADING THE CONFIGURATION

The complete set of data that controls the DSP processor is called a
configuration. This includes the parametric EQ and the link setting. It does not
include the volume setting.

SAVE THE CONFIGURATION

To save the current preset to a file, drop down the File menu and select Save
then “Save current configuration to computer.” Select the location in the file
system and enter the desired file name, then click Save.

File Restore Help

Save 3 Save current configuration to computer
Load configuration to device | JSF

It is recommended that you save your configuration to a file to ensure that
you do not lose them if you inadvertently reset the IL-DSP or upgrade your
computer.

LOAD THE CONFIGURATION

To load the configuration from a file, drop down the File menu and select
“Load configuration to device.” Locate the configuration file and click Open.

File Restore Help

Load configuration to device g

RESTORING TO DEFAULT

To restore the configuration to its factory default values, drop down the
Restore menu and select Current configuration.

File Restore Help

Current configuration
~o E|

15



NN

SPECIFICATIONS

Digital specifications
Audio resolution

Input sample rates
(PCM)

Direct-Stream Digital
(DSD) input

Internal DSP
processing

Analog specifications
Frequency response
Signal-to-noise ratio
THD + Noise

Power output

Physical characteristics
Dimensions (WxDxH)

Weight

Up to 24 bits
44.1, 48, 88.2, 96, 176.4, 192 kHz

DSD64/DSD128 (no DSP processing in DSD mode)

44.1 or 48 kHz (depends on input sample rate)

20-20 kHz, +/-0.2 dB

120 dB (32 Q, 1 kHz, A-weighted, digital in 0 dB)
0.0007% (32 Q, 1 kHz, 30 mW + 30 mW, mid gain)
100 30 mW + 30 mW (32 Q, 1 kHz, digital in 0 dB)

53 x17 x9 mm
50¢g

16
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IMPORTANT INFORMATION

DiSCLAIMER/WARNING

miniDSP cannot be held responsible for any damage that may result from the
improper use of this product or incorrect configuration of its settings. As with any
other product, we recommend that you carefully read this manual and other technical
notes to ensure that you fully understand how to operate this product. The miniDSP
audio processor is a powerful tool, and misuse or misconfiguration, such as incorrectly
set gains or excessive boost, can produce signals that may damage your audio system.

As a general guideline, you should perform the initial configuration of the miniDSP
audio processor before enabling audio through any connected output device or
amplification. Doing so will help ensure that the software is correctly configured.

Finally, note that the miniDSP audio processor is a very flexible device, and many of
the questions we receive at the tech support department are already answered in this
user manual and in the online application notes on the miniDSP.com website. So
please take the time to carefully read this user manual and the online technical
support. Thanks for your understanding!

WARRANTY TERMS

miniDSP Ltd warrants this product to be free from defects in materials and
workmanship for a period of one year from the invoice date. Our warranty does not
cover failure of the product due to incorrect connection or installation, improper or
undocumented use, unauthorized servicing, modification or alteration of the unit in
any way, or any usage outside of that recommended in this manual. If in doubt,
contact miniDSP prior to use.

FCC CLASS B STATEMENT

This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions:

This device may not cause harmful interference.

This device must accept any interference received, including interference that may
cause undesired operation.

Warning: This equipment has been tested and found to comply with the limits for a
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed
to provide reasonable protection. This equipment generates, uses and can radiate
radio frequency energy and, if not installed and used in accordance with the
instructions, may cause interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this equipment
does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:

17
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Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.
Notice: Shielded interface cable must be used in order to comply with emission limits.

Notice: Changes or modification not expressly approved by the party responsible for
compliance could void the user’s authority to operate the equipment.

CE MARK STATEMENT

The IL-DSP has passed the test performed according to European Standard EN 55022
Class B.

REVISION HISTORY

Revision Description Date
V0.1 Preliminary version 8 August 2019
V0.2 Preliminary for review 10 August 2019
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